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Chapter 1
Introduction



Read me first

Introduction

This manual provides guidelines about how to use Océ WPD® in order to print from
Adobe® Reader®.

Software requirements

■ Océ Windows Printer Driver, from its version 1.17.
■ Adobe Reader, from its version 8.

Scope of the guidelines

The procedures described in this manual have been selected to be as simple as possible.
Those guidelines have been tested for standalone workstations, with a wide range of
products.
As a result, they apply to:

■ all Océ wide-format technical printers (without folder).
■ all Windows environments supported by Océ WPD.
■ all document sizes.

Note:
Those guidelines do not apply to environments with a server.

Additional Océ resources

Océ constantly promotes and acts for a professional support to its customers.

Be ready to print with Océ WPD in just 5 clicks, without any IT knowledge needs. Indeed,
recent development enable us to provide you with an easy and intuitive installation wizard
for your printer driver.

Find also online support, available 24/7:

■ from the Océ Knowledge Base.
URL: http://global.oce.com/Support/Default.aspx#tab2
Ask a question and get the most pertinent answers.

■ from the Products web pages.
URL: http://global.oce.com
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Find the related printer driver, completed by a large panel of user manuals built to fit
your specific needs.

■ from the printer drivers' page
URL: http://global.oce.com/products/wfps-drivers/default.aspx
Find the right driver for your needs.
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Notes about Océ WPD® and Adobe Reader® interactions

Definition

This section provides some preliminary remarks to use the Océ WPD® printer driver
along with the Adobe Reader®.

Preview in the Print window of Adobe Reader®

In Adobe Reader, a 'Preview' feature (a thumbnail) is available from the 'Print' window.
The 'Preview' thumbnail does not take into account the settings you define in the
'Properties' window of the printer driver.

For instance, you change the scaling factor in the printer driver ('Properties' window).
This change is not replicated in Adobe Reader: the 'Preview' is independent from the
printer driver.

> Conclusion
As a consequence, the 'Preview' thumbnail is not a true printout preview. It just gives an
overview of the document content and not a "WYSIWYP"* display.
(* What You See Is What You Print)

General interactions

Print Setup window of Adobe Reader - Properties window of Océ WPD

Some settings are common to the Adobe Reader's 'Print Setup' window and to the Océ
printer driver. For instance, the 'Paper size', the 'Paper source',... are duplicated in both
locations.

> Conclusion
As a consequence, the preferred solution is to define those settings in the Windows
Printer Driver.

Layout settings interactions

Print window of Adobe Reader ('Page handling') - Properties window of Océ WPD
('Layout' tab)

Some settings, used to position your document on the printed output, are common to
Adobe Reader and Océ WPD. For instance:

■ In Adobe Reader, the 'Auto-Rotate and Center' and 'Choose paper source by PDF
page size' settings enable you to define the page layout.
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■ Equivalent settings are available in the Océ WPD printer driver: Rotation, Shift, etc.

For the page layout, the settings you define in the Adobe Reader replace the settings you
define in the Océ WPD.
This can lead to an unexpected image or document location on the printed output.

> Conclusion
As a consequence, the preferred solution is to define those settings from the Océ WPD
'Properties' window only.
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Introduction and prerequisite

Purpose

This manual provides guidelines to define the value of the print settings in Adobe Reader®

and in Océ WPD®.
Those guidelines allow you to print the inked area of your document on a selected page
size.

Before you go further, you must, first, define a Custom page size.
This Custom page size must be larger than the largest document you want to print.

Note:
If you use several printers, create the same custom page for each of them.
To ease this task, you can export and import the Custom 'Page size' via Océ WPD®.

Create a Custom Page Size with Océ WPD®

1. From the workstation's desktop, browse to the printers' page (Start - Printers and Faxes).
The 'Printers and Faxes' window opens.

2. Right-click on the printer name.
3. Select 'Printing Preferences...'.
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The 'Printing Preferences...' window opens.

4. From the 'Basic' tab, click 'Custom size'.
5. The 'Custom size' window opens.

#

ActionStep

■ Enter a value for the 'Width' of the custom page (for instance, 914).
■ Enter a value for the 'Length' of the custom page (for instance, 3000).

Note:
Customise the dimensions of the page according to your needs.

1
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ActionStep

Enter a name for this custom page.

Note:
Give an explicit name.

2

Click 'Save as local'.
Click 'Close' to exit.

3

Result

Click 'OK' to exit the Océ WPD 'Printing Preferences...' window.

From the driver's 'Basic' tab ('Page size' setting), always select this new custom page to
print any document from Adobe Reader.
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Chapter 2
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er®



Define the print settings

Purpose

Define the print settings in Adobe Reader® and in Océ WPD® before you print a file.

Note:
In this procedure, we assume you created your custom page size.
(‘Create a Custom Page Size with Océ WPD®’ on page 10).

Define the settings in Adobe Reader®

1. Open the document with Adobe Reader.
2. Click the 'Print' icon.

The 'Print' window opens.

3. From the 'Print' window:
#

ActionSection

■ Select the printer (drop down list for the 'Name' field).
■ Set the 'Comments and Forms' setting to 'Document'.

'Printer'
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ActionSection

Select the pages to be printed, if applicable.
(for more information, see: ‘Print range section’ on page 28)

'Print Range'

Set the 'Page Scaling' to 'None'.
Uncheck the 'Auto-Rotate and Center' box.
Uncheck the 'Choose paper source by PDF page size' box.

'Page Handling'

4. Click 'Properties'.
5. Go on with the next procedure: ‘Define the settings in Océ WPD®’ on page 15.

Define the settings in Océ WPD®

1. From the 'Properties' window that opens, select the 'Basic' tab:
#

ActionStep

Select your 'Page size'.

Note:
We recommend you to select the custom size you defined previously.
‘Create a Custom Page Size with Océ WPD®’ on page 10

1

Select the 'Landscape' orientation.2

Set the 'Media source' to 'Automatic'.3
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ActionStep

Set the 'Media type' to 'Use any media type' or 'Printer default' (according
to the selected printer).
Force to a specific 'Media type', if needed.

4

2. Click 'Cut size' to open the 'Cut size' window.
#

ActionStep

Set the 'Cutting Method' to 'Synchro'.1

Click 'OK'.2

3. Click 'Print area' to open the 'Print area' window.
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#

ActionStep

In the 'Printout' area, under 'Do you want to remove white areas around
the content?', click 'Yes'.

Note:
The other available settings depend on the selected printer.

1

Click 'OK'.2

4. Go to the 'Layout' tab and define those settings:
#

ActionStep

Select 'Custom scale'.1
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ActionStep

Set the X and Y scaling factors to 100%.2

5. In the 'Transformation' area, click 'More'.
From the 'Advanced layout' window that opens:
#

ActionStep

Set 'Mirror' to 'No'.1

Set 'Rotation' to 'Media saving'.2

Set 'Alignment' to 'Upper right'.3
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ActionStep

Click 'OK'.4

6. From Océ WPD, change other settings as needed (for instance: print quality mode, or
finishing option).

Save the Océ WPD® settings in a template for future use

1. Make sure you defined all the print settings you need in Océ WPD.
2. From the 'User Preferences' tab, click 'Templates'.
3. From the 'Templates' window that opens, click 'New'.
4. Give a name to the template you create and click 'OK'.

You created a template that contains all the print settings you previously defined.
5. Select your template from the list and click 'Apply'.

The template applies the print settings to the document you want to print.
6. From Océ WPD, click 'OK' to confirm and exit.

Note:
Apply the template you created to the custom page you use in Océ WPD. This custom
page and the print settings of the templates will apply to the document you want to
print.

Result

Go on with the next procedure: ‘Print from Adobe Reader®’ on page 20
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Print from Adobe Reader®

Before you begin

Make sure your defined the print settings in Adobe Reader® and in Océ WPD.
See: ‘Define the print settings’ on page 14

Print

1. If not yet done, click 'OK' to exit the 'Properties' window of the printer driver.
The Adobe Reader's 'Print' window is displayed again.

2. From this window, click 'OK' to send the file to the printer.
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Fuzzy information added to the printout

Question

■ Some PDF files are printed with black rectangles instead of text.
■ Part of the printout is clipped.
■ Background colour is replaced by another colour.
■ Unexpected white lines are visible on the printout.

Answer

1. Open the document with Adobe Reader.
2. Click the 'Print' icon.

The 'Print' window opens.
3. Click the 'Advanced' button.

The 'Advanced Print Setup' window opens.
4. Check the 'Print as image' box.
5. Click 'OK'.
6. Set all the other print settings as required (in the 'Print' window and in the printer driver's

'Properties' window)
7. Click 'OK' to print the file.
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Incorrect printout delivery

Question

■ Some PDF files are printed with black rectangles instead of text.
■ PDF files hang up in the Print Queue.
■ Parasitic white lines on the printout appear along the paper feed direction.

Answer

1. From the workstation's desktop, browse to the printers' page (Start - Printers and Faxes).
The 'Printers and Faxes' window opens.

2. Right-click on the printer name.
3. Select 'Properties'.

The printer's 'Properties' window opens.
4. Select the 'Advanced' tab.
5. Uncheck 'Enable advanced printing features'.

6. Click 'OK' to validate.
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Pixelated image

Question

The image printed on my colour printer is pixelated (Océ TCS500, Océ ColorWave 300
or Océ ColorWave 600).

Answer

1. In the Adobe Reader's 'Print' window, click the 'Properties' button.
The printer's 'Properties' window opens.

2. Select the 'Image' tab.
3. Set the 'Colour' field to 'Colour'.
4. Set the 'Colour feel' to 'Océ enhanced colours'.
5. Click the 'Enhanced colours' button.

The 'Enhanced colours' window opens.
#

ActionStep

Set 'RGB input data' to 'sRGB'.1

Set the 'Rendering intent' to 'Saturation (business graphics)'.2

Click 'OK'.3

6. Set the 'Print-file resolution' to 'Automatic'.
7. Set the 'Quality' to 'Presentation' or 'Release' (according to your printer).
8. Click 'OK'.

The 'Print' window is displayed again.
9. Click 'OK' to print the file.
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White pages

Question

White pages are delivered when printing a PDF file.

Answer

Force the print-file resolution to a lower value (for instance, from 'Automatic' or '600
dpi' to '300 dpi').

1. From the Adobe Reader's 'Print' window, click the 'Properties' button.
The printer's 'Properties' window opens.

2. Select the 'Image' tab.
3. From the 'Data Generation' area, set the 'Print-file resolution' to '300 dpi'.
4. Click 'OK'.

The 'Print' window is displayed again.
5. Click 'OK' to print the file
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Printout is incorrect

Introduction

It is possible that the printout from Adobe Reader/Océ WPD does not match with your
expectation. The print settings definition does not solve this situation, nor does the version
of the application.
Try one of the following alternative solutions.

Workaround 1

Use another reader instead of Adobe Reader.

Recommendation: Brava! Reader
(http://www.bravaviewer.com/downloadreader.htm)

Workaround 2

Print with the Océ Adobe® PostScript 3 (PS3) printer driver instead of WPD.

Direct download:
http://global.oce.com/products/wfps-drivers/downloads.aspx

Note:
An optional licence is required to directly print PDF or PS files to Océ wide-format
printers.
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Glossary for Adobe Reader®: Print window

Definition

This glossary provides some explanations about the settings you can find in the 'Print'
window of the Adobe Reader.
The descriptions below come from the Adobe Reader online help, available at the time
we write those printing guidelines.

Printer section

■ 'Comments and Forms'
Specifies which visible content prints.

#

DescriptionPossible values

Prints the document contents and form fields.Document

Prints document contents, form fields, and comments.Document And
Markups

Prints the document, form fields, and stamps, but no other
markups, such as note, comments and pencil lines.

Document And
Stamps

Print range section

■ 'Print range'
Specifies the pages to print.

#

DescriptionPossible values

Prints the page area (including text, comments, and so on) that
is visible in the current view.
The option name changes depending on whether you have no
pages selected (Current View), a page or pages selected (Selected
Pages), or an area on a page selected using the Snapshot tool
(Selected Graphic).

Current View (/Se-
lected Graphic)

Prints the page that is visible in the current view.Current Page

Specifies the range of pages to print in the open PDF.
Separate numbers in a range by using a hyphen, and separate
multiple pages or ranges by using commas or spaces.

Pages
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DescriptionPossible values

Choose' All Pages In Range', or choose 'Odd Pages Only' or
'Even Pages Only' to print only those pages within the specified
range.

Subset

Prints pages in reverse order.
If page ranges are entered, the pages print opposite of the order
in which they were entered (for example, if the Pages box shows
3–5, 7–10, selecting Reverse Pages prints pages 10–7, and then
5–3).

Reverse Pages

Page Handling section

■ 'Page Scaling'
Reduces, enlarges, or divides pages when printing.

#

DescriptionPossible values

Prints the upper left or centre of a page (if auto-rotated and
centered) without scaling.
Pages or selections that don’t fit on the paper are cropped.

None

Reduces or enlarges each page to fit the printable area of the
currently selected paper size.
For PostScript printers, the PPD determines the printable area
of the paper.

Fit To Printable
Area

Shrinks large pages to fit the currently selected paper size but
doesn’t enlarge small pages.
If an area is selected and is larger than the printable area of the
currently selected paper, it’s scaled to fit the printable area.

Shrink To Print-
able Area

Enables N-up printing, where multiple pages print on the same
sheet of paper.
If this option is selected, you can also specify settings for Pages
Per Sheet, Page Order, Print Page Border and Auto-Rotate
Pages.

Multiple Pages Per
Sheet

Prints multiple pages on the same sheet of paper in the order
required to read correctly when folded.
The printer must support duplex printing (printing on both
sides of the sheet). Acrobat automatically enables duplex print-
ing, if available, for booklet printing.

Booklet Printing

■ 'Auto-Rotate And Center'
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Adjusts the page orientation to match the orientation specified in the printer properties.

■ 'Choose Paper Source By PDF Page Size '
Uses the PDF page size to determine the output tray rather than the page setup option.
This option is useful for printing PDFs that contain multiple page sizes on printers
that have different-sized output trays. If this setting is unchecked, the same page size
(default page size selected in the driver properties) is used to print all the pages of the
document.

■ 'Use custom paper size when needed '
For printers capable of producing very large print areas, Acrobat supports pages as
large as 15,000,000 in. (38,100,000 cm) by 15,000,000 in. (38,100,000 cm).

'Print To File ' checkbox

Creates a device-dependent PostScript file of the document.
The resulting file contains code for enabling and controlling specific device features,
making it less compatible with devices other than the target device. For better results
when creating PostScript files, use the Save As PostScript command.
The Save As PostScript command isn’t available in Adobe Reader.

'Printing Tips ' button

If you’re connected to the Internet, this option connects to the Adobe website for infor-
mation on how to troubleshoot printing problems.

'Advanced ' button

Opens one or more panels for setting additional printing options.
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Glossary for Adobe Reader®: Advanced Print Setup window

Definition

This glossary provides some explanations about the settings you can find in the Advanced
Print Setup window of the Adobe Reader.
The descriptions below come from the Adobe Reader online help, available at the time
we write those printing guidelines.

Use the PostScript Options panel of the Advanced Print Setup window to set options for
a particular PostScript printer.
These options include how to handle non-resident printer fonts and whether to download
Asian fonts. If a PDF contains device-dependent settings, such as halftones and transfer
functions, these settings can be sent in the PostScript output to override the default settings
in the printer.

PostScript Options section

■ 'Language'
Specifies the level of PostScript to generate for the pages. Choose the level of PostScript
appropriate for your printer.

■ 'Font And Resource Policy '
Specifies how fonts and resources in the document are sent to a printer when those
fonts and resources aren’t present on the printer.

#

DescriptionPossible values

Downloads all fonts and resources at the start of the print job.
The fonts and resources remain on the printer until the job has
finished printing.
This option is the fastest but uses the most printer memory.

Send At Start

Downloads fonts and resources before printing the first page
that uses them, and then discards them when they are no longer
needed.
This option uses less printer memory. However, if a PostScript
processor reorders the pages later in the workflow, the font
downloading can be incorrect, resulting in missing fonts.
This option does not work with some printers.

Send By Range
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DescriptionPossible values

Downloads all fonts and resources for a given page before the
page prints, and then discards the fonts when the page has fin-
ished printing.
This option uses the least printer memory.

Send For Each
Page

■ 'Download Asian Fonts'
Prints documents with Asian fonts that aren’t installed on the printer or embedded
in the PDF.
The Asian fonts must be present on the system.

■ 'Convert TrueType To Type 1' (for Adobe Reader 9)
Converts TrueType fonts to PostScript fonts for PostScript file.
Some older PostScript output devices require this conversion.

■ 'Emit CIDFontType2 As CIDFontType2 (PS Version 2015 And Greater)'
Preserves hinting information in the original font when printing.
If unselected, CIDFontType2 fonts are converted to CIDFontType0 fonts, which are
compatible with a wider range of printers.
This option is available for PostScript 3 and PostScript Level 2 (PostScript version
2015 and later) output devices.

■ 'Discolored background correction'
Allows to correct severe discoloration during printing, such as white backgrounds
printing as yellow.

'Let printer determine colors' (for Adobe Reader 9)

In this workflow, the application does no colour conversion but sends all necessary con-
version information to the output device.
This method is especially convenient when printing to inkjet photo printers, because each
combination of paper type, printing resolution, and additional printing parameters (such
as high-speed printing) requires a different profile. Most new inkjet photo printers come
with fairly accurate profiles built into the driver, so letting the printer select the right
profile saves time and alleviates mistakes.
This method is also recommended if you are not familiar with colour management.
If you choose this method, it is very important that you set up printing options and turn
on colour management in your printer driver.
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Print As Image

Prints pages as bitmap images. Select this option if normal printing doesn’t produce the
desired results.
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